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Chapter 6, Exercise 6: Create Resources and Assign them to Tasks 
 

Are you required to report on resource work, or are resources just a label to identify who is doing what? 

Answering these questions will help you decide the level of resource management that you perform in 

Microsoft Project. Fully applying resource management in Project significantly complicates the use of the 

software. If you are unsure whether to use the resource features, the following exercises will help you 

decide the right level of resource management for you and your organization. 

 

Resource management is a large part of project management. It can be complicated and frustrating to 

anyone managing a team during a project. Resource creation, assignment and troubleshooting overwork 

is a major portion of Project’s extensive feature set. To use it, you need to experience it. 

 

The following multi-part set of exercises will walk you through creating resource types and assigning 

them to tasks. It also demonstrates the evaluation of assignments and the effect of task types on resource 

assignments. Task types come into play when resource leveling and complete the resource management 

topics covered in Microsoft® Project Do’s and Don’ts. 

 

Part 1: Create and define resources in preparation for assignment 

 

1. Open the file “Project Lifecycle_5.mpp.” 

 

2. Click on the View tab, and then click on Resource Sheet from the Resource Views command group. 

 

3. Add the Peak field to the sheet and move it next to Max Units. This will enable you to determine the 

severity of overallocated resources after assigning resources to tasks. 

 

4. Click on the Resource tab. 

 

5. Using the Add Resources button from the Insert command group, add four Work resources and one 

Material resource, as shown in the Resource Sheet below. Make sure you enter all the defining 

information as indicated by the highlighted text. 

 

Figure 6.1: The Resource Sheet contains or includes most of the relevant resource definition. 

 

 
 

Note that the Peak field is showing 0% because there are no resource assignments yet. Once there are 

assignments, this field will show the highest number of each Work resource required in the schedule.  
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Part 2: Assign resources to tasks 

 

1. To assign resources to tasks, you must return to a task focused view. Click on the Task tab, and then 

click on the Gantt Chart button shown in the View command group. 

 

2. Right-click on the task named “Create and negotiate definition documents” and choose “Assign 

Resources…” from the list that appears. 

 

3. Use Ctrl-click to select “MGT TEAM,” “PM” and “QA/QC” from the list of resource names shown in 

the Assign Resources dialog. 

 

4. Click on the “Assign” button to assign all three resources at one time to the task, “Create and 

negotiate definition documents.” This method of selecting and assigning multiple resources will save 

you a great deal of time as you move forward in using Project. 

 

Figure 6.2: The Assign Resources dialog for “Create and negotiate definition documents” after resources are 

assigned. 

 

 
 

5. Using the method of assignment above, continue to assign resources to tasks as illustrated in Figure 

6.3. Make sure that the number of Resource Units assigned matches what’s shown below. 
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Figure 6.3: Resource assignments 
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Part 3: Evaluating the resource schedule 

 

Once resources have been assigned, you will need to evaluate whether the resource schedule is tenable. 

This evaluation includes assessing overallocation and potentially leveling the project. The fundamental 

questions to ask are: 

 

1. Are there overallocations in the project? 

 

Yes! Examine the Indicators field in the Gantt Chart and you will see overallocations on tasks 3, 4, 7, 9 

and 10. The indicator for overallocation is a red icon symbolizing a person. The “Entry” table is pre-

formatted to contain the Indicators field. 

 

Figure 6.4: Overallocation indicators show in the Indicators field of the Gantt Chart’s “Entry” table. 

 

 
 

2. Which tasks have overallocated resources? 

 

Tasks 3, 4, 7, 9 and 10. 
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3. Which resources are overallocated? 

 

The Resource Sheet’s “Entry” table is pre-formatted to highlight overallocated resources with a bold red 

font, as well as with the overallocation indicator. PM and MGT TEAM are overallocated. 

 

Figure 6.5: The Resource Sheet identifies overallocated resources with an indicator and font coloring. 

 

 
 

4. How badly are the resources overallocated? 

 

The Max. Units (what you have) and Peak (what you need) fields in the Resource Sheet are used to 

determine severity. There is one PM, but two are required at some point in the schedule. There are two 

members of the MGT TEAM, but three are required at some point in their schedule. 

 

5. Are the overallocations severe enough to warrant leveling? 

 

If the overallocations occur over an extended period, care must be taken when resolving the problem. 

Continual overallocation may mean that the tasks require more staff to meet schedule goals, rather than 

delaying or splitting assignments, splitting tasks or modifying work periods. This question can be 

answered using the Resource Graph or the Resource Allocation views. 

 

Figure 6.6: The Resource Graph view compares Max Units to Peak graphically. (Click on the View tab | Resource 

Views command group | Other Views | Resource Graph from the list of views.) We see that the PM is overallocated 

for about 50 percent of the duration of task assignments. 
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Figure 6.7: The Resource Allocation view shows work assignments and overallocation in the timeline and identifies 

the tasks containing the overallocation. (Click on the View Tab | Other Views from the Resource Views command 

group | then More Views... | Resource Allocation view from the list of views.) 

 

 
 

6. Where in the schedule timeline are the overallocations? 

 

Using the Resource Graph and Resource Allocation views, you can determine that the weeks of August 7 

and August 13, 2017 contain the overallocations. 

 

7. What strategies should be used in resolving the overallocations? 

 

Here is where we see the aspects of project management’s art and science intersect. There is no one-size-

fits-all method of leveling. The fourth part of this exercise will illustrate leveling. 
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Part 4: Level the project 

 

Looking at the following figure, here is what we know from Project Statistics and from our resource 

assessment so far: 

 

 The project dates are currently 8/1/2017 to 9/19/2017. 

 The current duration is 35 work days. 

 There are 1,200 hours of work in the project currently. 

 The project cost is currently $108,080. 

 

Figure 6.8: Project Statistics gives the current state of a project. Look at it often by selecting the Project tab and 

clicking on Project Information. The Statistics button is at the bottom of the dialog. 

 

 
 

We also know that: 

 

 The overallocation date range is between August 7 and August 13, 2017. 

 Overallocated resources are those of the PM and the MGT TEAM. 

 Tasks having overallocation are 3, 4, 7, 9 and 10. 

 

The available leveling options and issues are pretty clear at this point: 

 

 The project is short, so we need to look at problems and solutions daily and use the entire 

project’s date range for leveling delays. 

 Since there are overallocations for about half of the project’s duration, we’ll have to use any 

method available in order to avoid delaying the project. If the project is already underway, this 

means adjusting assignments if necessary, delegating to qualified resources that aren’t 

overallocated and/or splitting any remaining work as needed. 

 

There is another leveling complication. Tasks 13 and 15 are not the default task type, and both tasks have 

contractual duration or work, and are thus, non-negotiable. They must not have duration or total work 

changed by leveling. In fact, the tasks summarized by “Conduct project work and reviews” are so tightly 

scheduled that these tasks need to be excluded from resource leveling. 
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Task priority is used in leveling to increase the likelihood that urgent or non-negotiable tasks are not 

modified by the leveling algorithm used by Project. Priority is set to a number between 1 and 1000. The 

larger the priority number, the less likely Project is to consider it in leveling. The default priority is 500; 

so, to make sure tasks 13-19 are not leveled, their priority should be larger than 500. Priority is not an 

absolute! If Project needs to delay a high priority task, it can do so. Only a constraint such as “Must Start 

On” totally removes a task from leveling, and this type of constraint is not recommended. Constraints 

limit Project’s dynamic scheduling capabilities! 

 

1. Set task priority of tasks 13-19 to “1000,” otherwise known as “Do not level." 

 

a. When changing information for multiple tasks, first select all tasks in the range. 

 

b. Right-click in the selected range and choose “Information” from the list. 

 

c. This brings up the “Multiple Task Information” dialog. 

 

d. In the General tab, click in the “Priority:” field and enter “1000.” 

 

e. Note the text that now appears just above the OK button. If the project can’t be leveled in its 

current state, Project may have no other choice but to keep the task definitions intact while 

moving them to a different point in time and still maintaining dependencies. This scenario 

usually results in a later finish date for the project. 

 

f. Click on OK. The selected tasks 13-19 will now not be included in leveling. 
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Figure 6.9: The Multiple Task Information dialog is used when applying a common characteristic to a group of 

tasks. In this case “Priority” was modified to “1000.” 

 

 
 

Now that the non-negotiable tasks are excluded from leveling, level the remainder of the project. Given 

the many restrictions and the amount of overallocation, our leveling settings should look as reflected in 

Figure 6.10.  
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Figure 6.10: Leveling Options are shown. Prior to leveling, it’s wise to see what options are turned on and what 

other choices you’ll have. 

 

 
 

One checkbox in the options for Resource Leveling can be tricky to work with. “Level only within 

available slack” prevents the finish date of your project from being delayed. In general, it should be 

checked if the finish date is non-negotiable. Unchecked, it allows the finish date to be delayed by 

whatever number of working days is required to level resources. The default for this checkbox is 

unchecked. 

 

If Project needs to delay the project finish date, but can’t because the box is checked, it delays the tasks it 

can and then gives you leveling error messages. In other words, if you can’t allow for more schedule, 

then you should look for additional qualified resources. If Project needs to delay the project finish date 

and the box is unchecked, Project is free to do so. Once you have configured the settings to according to 

your need, you should attempt leveling. 

 

2. Level without delaying the project finish date. 

 

a. In the Leveling Options dialog, check “Level only within available slack,” and then click on 

the “Level All” button. 

 

b. Ask important questions: Is the project still overallocated? Which tasks and resources are 

overallocated? 

 

c. Return to the Leveling Options dialog, and click on “Clear Leveling.” When prompted, 

choose “Entire Project,” and then click on OK. 

 



38 

 

d. Return to the Leveling Options dialog. Un-check “Level only within available slack,” and 

then, click on the “Level All” button. 

 

3. Overallocations should be resolved. Check Statistics one final time. Ask the following questions: 

 

a. What is the finish date of the project? 

 

b. Is the date earlier or later than the original finish date? 

 

4. Save the file as “Project Lifecycle_6.mpp.” 

  


